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NEW FEATURES AND CHANGES COMPARED TO TEKLA STRUXML IMPORT 1.0.003

ADDED:

1. Compatibility with Tekla Structures 2017i.
Possibility to convert axes and storeys

It is possible to convert struxml axes and storeys to Tekla grid system. Read more in Chapter
2.3.5 B.

FIXED:

3. It is now much faster to switch options on and off (e.g. check / uncheck Type and Status
options) at models containing large number of elements.

NEW FEATURES AND CHANGES COMPARED TO TEKLA STRUXML IMPORT 1.0.002

ADDED:

4. Compatibility with Tekla Structures 2017.
5. New user-defined input parameters are available in the Options tab.

It is possible to define Prefix input parameters for imported elements. More in Chapter 2.3.4.
6. Possibility to save the Options tab settings as Default.

It is possible to save the setting in Options tab as default, and load those settings for a new
project, More in Chapter 2.3.4.

CHANGED:

7. User-defined input parameters can be defined separately for concrete and steel objects. More in
Chapter 2.3.4.
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1. Introduction

1.1. Manual scope

This document describes the concept behind the link between FEM-Design and Tekla Structures, and
explains how to exchange data between those two programs using the Tekla StruXML Import tool.

1.2. Installation

Download the latest version of Tekla StruXML Import from StruSoft Installer or from FEM-Design
Download Center and run the installation file.

When the installation process is completed, Tekla StruXML Import tool will appear under StruSoft
folder in the Start menu, as shown in Figure 1-1.

l StruSoft

@ Change StruSoft license settings

'a Read me

L . = -
3 SBISteelConnections

Strusoft Installer

Tekla StruXML Export

Tekla StruXML Import
. Uninstall

Uninstall

User Manual

Figure 1-1
1.3. Concept

Tekla StruXML Import Tool enables direct communication between FEM-Design and Tekla Structures.
The direct data transfer is based on conversion of FEM-Design analysis model transfer into Tekla
Structures native objects. FEM-Design analysis model is saved as struxml file type and converted to
Tekla native objects in the Tekla StruXML Import tool. The proper sections and materials are
assigned to Tekla native objects in the mapping process.

1.4. Functionality

The Tekla StruXML Import Tool has the following functionality (Figure 1-2):

- importing FEM-Design model to create a new Tekla Structures model,
- updating Tekla Structures model with changes made in FEM-Design model after the initial
import.

One can import / update:

- selected element(s),
- group of elements (e.g. all beams, columns, etc.),
- all elements.


http://download.strusoft.com/FEM-Design/inst150x/newlicsys/
http://download.strusoft.com/FEM-Design/inst150x/newlicsys/

Tekla StruXML Import

FEM-Desi odel
esign mode Tekla m

-Version 1-

Import struxml_1 to CREATE
> -Version 1-

(struxml_1) new model in Tekla

FEM-Design model
Import struxmi_2 to UPDATE Tekla model

-\ersion 2- = _
the current model in Tekla -Version 2-

(strizeml_2)

Figure 1-2

When updating the Tekla model, changes (in comparison to the initially imported objects) are
recognized on both FEM-Design (struxml) and Tekla side. Following changes can be recognized:

- new element (only in struxml),
- modification of an element (in struxml and in Tekla),
e section / thickness
e material
e geometry
e ID (only in struxml)
- deletion of element (in struxml and in Tekla).

If certain object is changed, it is assigned to one of the status categories: New, Modified, Deleted or
Conflicted. Also, a certain type of change is reflected in the object name (Figure 1-3):

- object type is bolded when geometry changed,
- section name is bolded when it changed,

- material name is bolded when it changed,

- IDis bolded when it changed,

- object name is strikethrough if it was deleted.

The same rule applies if an object is changed in Tekla. Certain part of the Tekla name is bolded or
strikethrough to reflect the change type.

&) Tekla StruXML Import — O by

Import | Materials | Sections | Options |

File name CAUsers\lwonat\Desktoph2.struxml
Type StruXML Tekla
¥]Beam (3) ) Beam'B.1.1' [Rectangle 150x300] [C30/37] Beam 'BEAM' [3007150] [C30/37]
Column (0) @ Beam 'B.2.1' [Rectangle 150x400] [C30/37] Beam ‘BEAM' [300-150] [C30/37]
E,_I;tue [[Dt;] 0 Beam'B.3.1'[Rectangle 150x300] [C16/20] Beam 'BEAM' [3007150] [C30/37]
Status © Beam'BB.1.1" [Rectangle 150x300] [C30/37] Beam 'BEAM' [3007150] [C30/37]
New (0) @) Beam!'B51'[Rectangle 150x30011C30/37] Beam 'BEAM' [300°150] [C30/37]
] Modified (4)
[/] Deleted (1)
Conflicted (0)

Figure 1-3

One can accept a certain change (and update the Tekla object), or deny (ignore) it. Each object can
be treated individually.
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1.5.

Designed workflow

The workflow to import a FEM-Design model into Tekla Structures is shown in the Figure 1-4:

Type

Impart

&) Tekla StruXML Import

| Materist  Secions | Options

Filemame | CAUsers\lwana\Desktop\Export modelstruxmi

StruXML

#IBeam @) © Beam'B.A.1"[HE-A 300] (5 355]
[ Column (146) || ) peamB.2.1' (HE-A 300 15 3551
E;'.'.".f . © ColumnC.1.1" [Rectangle 300x400] (C30/37)
Status. ® .
[ New (306) ® c
Modified (©) ® c

| actare |

Rectangle 300x400] (C30/37]
1" [Rectangle 300x400] [C30/37]
A1 [Rectangle 300x400] [C30/37]
© Column*C5.1 [Rectangle 300x400] [C30/37]
© Column*C.6.1" [Rectangle 300x400] [C30/37]
) Column*C.7.1° [Rectangle 300x400] [C30/37]
© Column*C.8.1 [Rectangle 300x400] [C30/37]
) Column'C.9.1' [Rectangle 300%400] [C30/37]
&) Column*C.A0.1" [Rectangle 300x400] [C30/37)

<

|

1.6.

The list of transferred and converted data is as follows:

Transferred data

Figure 1-4

Open an existing FEM-Design model

- Save the model as struxml file type.

Start the Tekla StruXml Import tool

- Load the struxml file.

- Map the materials and sections.

Set additional options.

Import the model to Tekla Structures.

Model is created in Tekla Structures

geometry of FEM-Design analysis model (beams, trusses, columns, plane walls, plane plates),
mapped cross-section of linear members (beams, trusses, columns),

thickness of plane walls and plane plates,

mapped material,

analytical element ID of an object (optional).
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2. Tekla StruXML Import

This chapter explains the detailed workflow of the integration between FEM-Design and Tekla
Structures, as well as the functionality of the Tekla StruXML Import tool. In the table below, a

detailed workflow is described.

IMPORT FEM-DESIGN MODEL TO TEKLA

In FEM-Design:

In Tekla:

In Tekla StruXML Import:

In Tekla:

Save FEM-Design model as .struxml file type (Chapter 2.1).

Start Tekla Structures and open an existing model, or create a new model
(Chapter 2.2).

Start Tekla StruXML Import tool (Chapter 2.3).
In the Import tab load the struxml file (Chapter 2.3.1).

Go to Materials tab and map all the materials used in the model (Chapter
2.3.2).

Go to Sections tab and map all the sections used in the model (Chapter
2.3.3).

Go to Options tab and decide upon the optional settings (Chapter 2.3.4).

Go back to Import tab, select an element / elements to convert to Tekla
model and press Convert (Chapter Error! Reference source not found.).

Close the Tekla StruXML Import tool.

Continue working with the imported model and when finished, Save the
model (with the original name).

UPDATE TEKLA MODEL

In FEM-Design:

In Tekla:

In Tekla StruXML Import:

In Tekla:

Save the new version of the earlier imported FEM-Design model as .struxml
file type.

Open the previously imported model.
Start Tekla StruXML Import tool.
In the Import tab load the new struxml file (Chapter 2.3.1)..

If necessary, go to Materials tab and map all the new materials used in the
model (Chapter 2.3.2).

If necessary, go to Sections tab and map all the new sections used in the
model (Chapter 2.3.3).

If necessary, go to Options tab and decide upon the optional settings
(Chapter 2.3.4).

Go back to Import tab, and verify the status of elements (Chapter 0).

- Select an element / elements and press Convert if you wish to update
the Tekla element to the struxml version.

- Select an element / elements and press Ignore if you wish to ignore the
element and do not update the Tekla element to the struxml version.

Close the Tekla StruXML Import tool.

Continue working with the imported model and when finished, Save the
model (with the original name).

10
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2.1. Saving FEM-Design model

In FEM-Design go to File -> Save as and save your model as .struxml file type. Struxml file type is
an alternative FEM-Design format that among other things, is used as data exchange format
between FEM-Design and other programs such Tekla Structures and Revit.

[ FEM-Design 15 - 3D Structure - Complete structure.struxml
File Edit Draw Modify Tools Settings View Window Help
Sinuciure | Loads Finteclements  Analysis  Foundafiondesign  RCdesign  Stesldesign  Timberdesign  Performarnce based desion

SR = NN N MG Mikia § 22201 28] 00

Datum Fo... Bar Plate Wall Support Modeling tool Cover

LEGl¢0000 oUAd +* 90 anlclg@oa)le/ ¢+ GOnOBR=Laostmt AOOOLIEE S]] -

Euracode (Ma: Swedish)

{3 save as X
>\ /< Savein: | || Tekla Import model ~] @& m-
\ \ /< * Name - Date modifi
g Q No items match your search,
\_\_ U Quick access
“-\\\ ﬂ \] /< Desktop
~— | [Pl 3 -
Ny [ \ Libraries
] ~= | =
;\\ Q This PC
Network ¢ %
File riame: Complete structure strusanl | Save
Save astype StruSoft common structure XML file ("stuoml) — ~ Cancel
FEM-Design, 3D Structure (*str}
AutaCAD drawing (*dwa)
AutoCAD crawin
Figure 2-1

2.2. Creating Tekla model

Start Tekla Structures and open an existing model, or create a new model.
ﬁ Tekla Structures x4

File Edit View Modeling Analysis Detailing Drawings & Reports Tools Window Help
DPE < GEBRE Ve AR ne X ERENE %%l
gl iLmek@X[ 1 ohoRil[H aY ~ & [EEEZ

ENew

Save in: | Ch\TeklaStructureshModels', V| | Browse...

Model name: |Test model| fp— |

Model template: |(NOHEJ v|
Model type: | Single-user | Server name:
Figure 2-2

If you consider updating your Tekla model later, you must keep the same name of the Tekla
model. If you save your initially imported model with a different name, all the identifiers will be
changed and there will not be possibility to update the model later.

11
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2.3. Tekla StruXML Import tool

Start the Tekla StruXML Import tool. Remember that Tekla Structures has to be opened in
the background. The tool will first establish connection to the Tekla Structures.
&

Import | Materials | Sections | Options

File name Browse

StruXML Tekla

Ignare Activate Convert

Connected to Tekla Structures 21.1

Figure 2-3

2.3.1. Import tab

Press Browse and locate the struxml file containing the FEM-Design model that you wish to import
to Tekla. Upon loading the file the dialogs in the Import tab become active just as shown in the
example in Figure 2-4.

There are four main dialogs in the Import tab:

- Filter window

- Objects list

- Actions window

- Log area

2.3.1.1. Filter window

Elements in the struxml file are filtered by two parameters: Type and Status.

Following Type of element is recognized:

Beam: Beams and truss members in struxml
Column: Columns in struxml

Plate: Plane plates in struxml

Wall: Plane walls in struxml

Following Status of an element is recognized:

New: New element in struxml (not existing in Tekla model before)

Modified: Element has been modified in struxml or in Tekla after the initial import
Deleted: Element has been deleted in struxml or in Tekla after the initial import
Conflicted: Element is modified both in struxml and in Tekla after the initial import
Ignored: User ignored the element and did not convert it to Tekla

Matching: Element has a matching status between struxml and Tekla

12
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Following rules apply:

- If an element of a specific type and status exist in the loaded struxml file, the corresponding

category will be bolded and selected by default.

- The value in parenthesis shows the total humber of elements belonging to certain category.
- Elements belonging to selected categories in the Filter dialog are visible in the Object list.

(| L

&) Tekla StruXML Import

Import | Materials | Sections | Options

File name ChUsers\lwona\Desktoph2016-03-18 Tekla Import test\FD medels\Complete structure.struxm|
'rFPE \ StruXML Tekla
Beam (0) Column 'C.1.1° [HE-A 200] [S 355] -
] Column (61) © Column’C.2.1' [Square 300] [C30/37-1]
:'.I:IT [(35;) @ Column'C.3.1' [Square 300] [C30/37-1]
Status g Column "C.4.1" [Square 300] [C30/37-1]
Column "C.5.1" [Square 300] [C30/37-1] -
::if'::g][(]} © Column C.6.1' [HE-A 200] [S 355] ; OBJECTS LIST
Deleted (0} @ Column'C.7.1" [Square 300] [C30/37-1]
Conflicted (0) & Column'C.8.1" [Square 300] [C30/37-1]
lgnored (0] © Column'C.9.1" [Square 300] [C30/37-1]
Matching (0} Column "C.10.1" [Square 300] [C30/37-1]
FILTER WINDOW Column "C.11.1" [HE-A 200] [S 352 - Z
N——— Ignare Artivate ACTIONS WINDOW Convert

[ Connected to Tekla Structures 21.1

Loading StruXML file C\Users\lwona\Desktop\2016-03-18 Tekla Import test\FD models\Complete structure.struxml
Processing StruXML entities
Refreshing Tekla data

@ Loading StruXML file succeeded
LOG AREA

\

About  Manual

Close

Figure 2-4

2.3.1.2. Objects list
This dialog is divided into two parts: StruXML and Tekla (Figure 2-7):

- In StruXML column, one can see a list of all elements from the struxml file (according to selected

type or status filter).

- In Tekla column, one can see a list of corresponding objects that have been converted to Tekla

(before the elements are converted, the Tekla column will be empty - Figure 2-5).

The naming convention is following:

StruXML Tekla

Type 'ID’ [Sections or Thickness][Material] Type ‘Name’ [Sections or Thickness][Material]

13
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This is how the dialog looks like just after loading a struxml file. All objects in StruXML side are red
because the mapping was not perform yet (a tooltip is shown if you hover a mouse over any object).
The Tekla column is empty because no elements were converted to Tekla yet.

] - R R N L j = 1

4 Tekla StruXML Import — O pd

Import | Materials | Sections | Options |

File name Ch\Users\lwona\Desktop\2016-03-18 Telda Import test\FD models\Complete structure.struxml
Type StruXML Tekla
Beam (0) © Column'C.1.1' [HE-A 2001 [S 355] : A
Col 61
olumn_(61) @ Column'C2.1| Cannot map StruXML section to Tekla profile!
Plate (3) & Column'C.3.1| Cannot map StruXML material to Tekla material!
[V Wall (33)
Stat e Column "C.4.1" [Square 300] [C30/37-1] -
us
MNew (99) @ Column'C5.1" [Square 3001 [C30/37-1] -
Madified (0) @ Column'C.6.1' [HE-A 200] [S 355] -
Deleted () @ Column'C.7.1" [Square 3001 [C30/37-1] -
Conflicted (0) ° Column "C.8.1" [Square 300] [C30/37-1] -
L ~ o 1m o aire santesanme -
Ignored (0} | Ignore ” Activate | Convert

Connected to Tekla Structures 21.1
Loading StruXML file C:\Users\lwona\Desktop2016-03-18 Telda Import test\FD models\Complete structure.struoeml
Processing StruXML entities
Refreshing Tekla data
@ Loading StruXML file succeeded

About  Manual Close

Figure 2-5

This is how the same dialog looks like after completing the mapping (all objects are now in black):

€ Tekla StruXML Import — O by

Impart | Materials | Sections | Options |

File name C\Users\lwona'\Desktoph2016-03-18 Tekla Import test\FD models\Complete structure.struxml

Type StruXML Tekla

Beam (0) ' Column*C.1.1' [HE-A 200] [S 355] - ~
[v]Column_(61) @ Column*C.2.1" [Square 300] [C30/37-1] .
::T [(35;) @ Column "C.3.1" [Square 300] [C30/37-1] -
Status ) Column'C.4.1" [Square 300] [C30/37-1] -
] New (99) @ Column 'C.5.1" [Square 300] [C30/37-1] -
Modified (0} ) Column'C.6.1' [HE-A 200] [S 355] -
Deleted (0) & Column 'C.7.1" [Square 300] [C30/37-1] -
Conflicted (0) ) Column*C.8.1" [Square 300] [C30/37-1] -

- ie o aree nonreanmo e -

Ignored (0} | ignore || acivae |

Connected to Tekla Structures 21.1
Loading StruXML file C\Users\lwona\Desktop\2016-03-18 Tekla Import test\FD models\Complete structure.struxml
Processing StruXML entities
Refreshing Tekla data
@ Loading StruXML file succeeded

About  Manual Close

Figure 2-6

14
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And this is how the same dialog looks like after converting all objects to Tekla:

5 Tekla StruXML Import

Import | Materials | Sections | Options

File name

il Type
Beam

Column (61)

CUsers

a\LesKiop

=] ADOYT  napny

Browse

StruXML
Column 'C.1.1" [HE-A 200] [S 355]
Column 'C.2.1" [Sguare 300] [C30/37-1]

Tekla
Column *COLUMMN' [HEA200] [S355)R]
Column *COLUMN' [300*300] [C30/37]

Plate (5) ) ;
| Wall (33) Column 'C.3.1" [Square 300] [C30/37-1] Column "COLUMMN' [300°300] [C30/37]
a

|| stat Column 'C4.1' [Square 300] [C30,/37-1] Column "COLUMN' [3007300] [C20/37]

atus
( e Column 'C.5.1' [Square 3001 [C30/37-1] Column 'COLUMN' [300*300] [C30/37]
[ 0 Column 'C6.1' [HE-A 200] [5 353] Column *COLUMMN' [HEAZ200] [S335JR]
{ D ) Column 'C.7.1" [Square 300] [C30/37-1] Column "COLUMMN' [300°300] [C30/37]
: Co 0 Column 'C.8.1' [Square 300] [C30,/37-1] Column *COLUMMN' [300%300] [C30/37]
I o Column 'C.9.1' [Square 3001 [C30/37-1] Column 'COLUMMN' [300*300] [C30/37]
! - -. o Column 'C 101 [Sauars 3001 H300/37-11 Coluwmn COLLIRAR T300* 3001 [CIN0/371 |
I Matchlng 09 Ignore Activate et
3 Creating Wall "W.29.1

®c eted

Figure 2-7

2.3.1.3. Actions window

Here is where the user decides what to do about a selected object(s). One can press Convert, in
order to convert (import or update) selected object(s) to Tekla.

One can press Ignore, in order not to convert (import or update) selected object(s) to Tekla. One
can press Activate, in order to activate back an ignored object.

2.3.1.4. Log area

Here is where the user can see all the log messages that the tool sends when processing the model.
When importing / updating the model, each action type is reflected in certain message (Figure 2-7),
e.g:

- Creating Beamy/Column/Plate/Wall ID

- Modifying Beamy/Columny/Plate/Wall ID

- Deleting Beam/Columny/Plate/Wall ID

In case of some recognized problem (e.g. unsupported contour of plate), a warning message will be
displayed below the processed object.

2.3.2. Materials tab

In the Materials tab one should map all the materials used in the FEM-Design model into
corresponding materials from Tekla Material Catalog.

In the left part of the dialog called StruXML, one can find list of all materials* used in the FEM-
Design model, just as shown in Figure 2-8.

*Some material names can be listed several times (if they have different application data properties in FEM-Design).

15
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€ Tekla StruXML Import - m] X

Impaort | Materials | Sections | Options

StruXML Tekla
C25/30-1
C30/371
5355
Figure 2-8

In the right part of the dialog called Tekla, one should type (or paste) the corresponding material
name from Tekla Material Catalog, just as shown in Figure 2-9.

4 Tekla StruXML Import — O ®
p

Import | Materials | Sections | Options

StruXML Tekla
€25/30-1 C20/35
C30/371 C30/37
5355 S355)R
Figure 2-9

In order to find the name of Tekla material, one can open Tekla Material Catalog (it can be open
simultaneously with Tekla StruXML Import tool) and browse through the library. Certain material
name can be copied to the particular cell in the Materials tab.

s Modify Material Catalog X
Selected grade: ISBSSJR I General Analysis Design User attributes

=- Steel

- AlSI304

Ak

- Existing_Steel

- 523510
§235)2G3

- 523512G4

-~ 5235JR

- 5233JRG1 € Tekla StruXML Import - @O X
- 5235)RG2
.. 52750 Import | Materials | Sections | Options

.. 5275)2G3 StruXML —

52751264
TSR €25/30-1 €20/35
5350GD-Z C30/37-1 C30/37

- 5335)0 5333

- 5335)2G3

.. 5355)2G4

.. 5355)2H

e 5335JR

- 5355K2G3

- 5335K2G4

-~ 544012H

- 533012H

. Steel_Undefined
X60

L XT0

- Concrete

- Reinforcing bar

- Timber

[Fes10B

Alias 2:

Alias 3
o
Profile density: | 785500 | kg/m?
~
Plate density: | 7850.00 N | kgrm?

[ i |

- Miscellaneous

Filter: Filter.

oK Export... Impoﬁ Connected to Tekla Structures 21.1

Loading StruXML file C:\Users\lwona\Desktop'2016-03-18 Tekla Import test\FD models\Complete structure.struxml

Figure 2-10
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2.3.3. Sections tab

In the Sections tab one should map all the sections used in the FEM-Design model into
corresponding sections from Tekla Profile Catalog.

In the left part of the dialog called StruXML, one can find list of all sections used in the FEM-Design
model, just as shown in Figure 2-11.

&) Tekla StrudML Import — O ®
Import | Materials | Sections | Options
StruXML Tekla
HE-A 200 |
Square 300
Figure 2-11

In the right part of the dialog called Tekla, one should type (or paste) the corresponding section
name from Tekla Profile Catalog, just as shown in Figure 2-12.

€ Tekla StruXML Import — O x

Import | Materials | Sections | Options

StruXML Tekla

HE-A 200 HEA200

Square 300 3007300
Figure 2-12

In order to find the name of Tekla section, one can open Tekla Profile Catalog (it can be open
simultaneously with Tekla StruXML Import tool) and browse through the library. Certain section
name can be copied to the particular cell in the Sections tab.

& Modify Profile g X
Profile name; [HEA200 | | General  Analysis User attributes
. — Profile type
Fiter [ [Tk broficype: | LI profies 7]
£ I profiles ~ \‘P@L
2146 HEA Profile subtype: rolled ~]
& HEAI0 Calculoted cr| & Tekda Struxhi - b x
- HEAT20
@ HEAID St [0 |mpart | Materials | Sections | Options
g Ea}:ﬁ R StruXMIL \ Telda
& e HE-A 200
& HEAZ20 Square 300 2007300
& HEA40
- HEA260
&P HEA280
- HEA300
.. HEA320
&P HEAD
&P HEA360 Property
&P HEA4DD Height
- HEA4S0 Width
&P HEASDD Web thicknes
- HEAS50 Flange thickn
@ HEAGDD Rounding rad
-~ HEAGSD Rounding rad
@ HEATOD Flange slope
&P HEAS0D
{0 HEADD
&P HEA1000
A8 HEAA
9 HEB
#8 HEC
8 HEM
*8 HD
'zg ::: @ Loading StruXML file succeeded
- HI
& PHI
- WI v
oK Export.. | | Import.. | Import Directory...
1

Figure 2-13
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Pay attention when mapping e.g. rectangular concrete sections. There is a different naming
convention of the concrete sections between FEM-Design and Tekla.

In FEM-Design, a naming convention for a default concrete rectangular section is following: bxh,
where b is the width of a section, and h is the height of the section e.g.: 150x300 (Figure 2-14).

In Tekla, naming convention for a default concrete rectangular section can be following: h*b, where
b is the width of a section, and h is the height of the section e.g.: 300*150 (Figure 2-15).

3
Beam/Column >
General I Section b End conditions b Physical model @ Material
The same at both ends Start End
- 120%250 A z
- 120x300
- 120%350
- 120%400
- 150%200 1 Gls ¥
-+ 150x250 [w] F
-1150x300
- 150x350
- 150x400
- 150x450 I’
Figure 2-14
&3 Select Profile *
Profile name: | Bo0~150 w| General Analysis User attributes
Profile type
Filter. [ Filter Profiletype: | | Plate profiles v|
EJ-"g:l: | profiles " Profile subtype: | h*b V|
#-13 | beams (steel)
- L L profiles Calculated cross section area
- Z profiles Stat | End |
-l U profiles )
-3 C profiles SELs
m- T T profiles
m-JT Welded box profiles
-3 Welded Beam profiles h
-3 Box profiles
- J1 WQ profiles b
(= I Rectangular sections
G
& BL
&7 erL Property Sy Value Unit
: g E;T Height h 300.00 mm
Ca Width b 15000 mm

Figure 2-15

So a rectangular beam 150x300 in FEM-Design has to be mapped as shown in Figure 2-16, in order
to be imported correctly to Tekla.

StruXML

Rectangle 150x300

Figure 2-16
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2.3.4. Options tab

In the Options tab, one can decide about optional settings regarding the imported data (Figure

2-17).

€5 Tekla StruXML Import

Importl Materials | Sectionsl Options |

Importing data

[] Put StruXML Identifier into User Field 4' of the Tekla object
[] Put user-defined input parameter for model object default

Concrete Name Class Prefix (Cast Unit)
beam

column

plate

wall

m Name Class Prefix (Part) Prefix (Assembly)

beam
column

plate

Save as default | ‘ Load as default

Figure 2-17

There are two options:

- Put StruXML identifier into “User Field 4" of the Tekla object

If this is option is checked, the analytical ID of FEM-Design object (Figure 2-18) will be imported
along with its geometry, and placed in the User-defined attributes of the Tekla object, in User

field 4 (Figure 2-19).

Figure 2-18

ﬁ Concrete Beam Properties X

| standard "| Save as | | standard

Attributes  Position Cast unit Deforminn

MName BEAM

s Tekla Structures x64 Concrete beam (1)

& Profile @ EliPlan BVBS HMS General Design

Parameters Workflow End Conditions

Analysis IFC export

Material C30/37

Comment
ek I: Preliminary mark
Class |:1 Locked
Fabricator name

User field 1

User field 2
User field 3
User field 4

User Phase ([affects numbering)

Figure 2-19
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- Put user-defined input parameter for model object default

If this option is checked, the fields below become active and one can define the Name, Class
and Prefix parameters for each type of imported objects, separately for concrete and steel
elements, as shown in Figure 2-20. If this option is not checked, all objects will receive default
parameters.

€ Tekla StruxML Import
Import | Materials | Sections | Options
Importing data

[ Put StruXML Identifier into User Field 4' of the Tekla object
Put user-defined input parameter for model object default

MName Class Prefix (Cast Unit)

beam Concrete beam 1 CB

column Concrete column 2 =

plate Concrete slab 3 G5

wall Concrete wall 4 cw
m MName Class Prefix (Part) Prefix (Assembly)
beam Steel beam 5 sb SB
column Steel column 6 sC SC
plate Steel plate T sp SP

Save as default | | Load as default |
Figure 2-20

If this option is checked, the user-defined input parameters will replace the default parameters
for the particular element, as shown in Figure 2-21.

W Concrete Panel Properties & Concrete Panel Properties b4
Save |Load |standard ~ | Saveas |standard Save| [Load ——
Attributes  Position Castunit  Bending Attributes | Position  Castunit | Bending
Name | Concrete wall — | Nurnbering series
Profile [2060240 || select.. et W  |AStart number
:
Material [ C25/30 [ setect.. Cast unit type
Finish | | Pour phase Cl
Class |4 — |
User-defined attributes...
o« Apply Modify Get F / L e 0K Apply Madify Get o / r Cancel
Figure 2-21

One can save the Options using ‘Save as default button’. When starting new project, use ‘Load
as default’ in order to import default options.
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2.3.5. Import (convert)
A. Convert structural elements
Follow this example to understand the simple import mechanism.

After loading a struxml file and completing sections and materials mapping (and choosing optional
setting) the Import dialog looks like on Figure 2-22.

&) Tekla StruXML Import - O b4
Import | Materials | Sections | Options

i CA\Users\lwona'\Desktoph2016-03-18 Tekla Import test\FD models\Complete structure.struxm
ile name rowse

Type StruxML Tekla
seam (U} 7 Column*C.1.1" [HE-A 200] [S 355]
Column (61) ) Column'C.2.1" [Square 300] [C30/37-1]

/] Plate (5) —
W e ' Column 'C.3.1' [Square 300] [C30/37-1]
a -
Stat _ Column'C.4.1' [Square 300] [C30/37-1]
atus
_ Column"C.5.1' [Square 300] [C30/37-1]

[ New (99)
Vodifed O " Column’C.6.1" [HE-A 200] [§ 355]

Column 'C.7.1' [Square 300] [C30/37-1]
Column 'C.8.1" [Square 300] [C30/37-1]
Column 'C.9.1" [Square 300] [C30/37-1]
Column 'C.10.1" [Square 300] [C30/37-1]
Column "C.11.1"' [HE-A 200] [S 355]
Column "C.12.1' [HE-A 200] [S 355]
Column "C.13.1"' [HE-A 200] [S 355]
Column "C.14.1"' [HE-A 200] [S 355]
Column "C.15.1' [HE-A 200] [S 355]

Ignore Activate Convert

Figure 2-22

In order to convert (import) object to Tekla:

- select a certain object (it will highlight in blue) or,
- select a group of objects (click on several objects with Ctrl button pressed) or,
- select one random object and press Ctrl+A in order to select all objects (Figure 2-23)

and press Convert*.

*Since version 1.1.004, the Convert button is called Convert objects.

21



Tekla StruXML Import

£ Tekla StruXML Import - ] X
p

b Import | Materials | Sections | Options |

File name |C:\Users‘\lwana‘\Desktop\Em 6-03-18 Tekla Import test\FD models\Complete structure.struxml | | Browse
Type StruXML Tekla
[JBeam (0) @ Column'C.1.1* [HE-A 200] [S 355] .

Column (61) Column "C.2.1* [Square 300] [C30/37-1]

:::f [g) : Column 'C.3.1° [Square 300] [C30/37-1]
Status ":‘ Column 'C.4.1 [Square 300] [C30/37-1]
7 New (99) @ Column'C5.1" [Square 300] [C30/37-1]
[] Modified (0) © Column’C6.1"[HE-A200][S355]
[[] Deleted (0) Q 7.1" [Square 300] [C30/37-1]
[ Conflicted (D) @ Column'C.8.1" [Square 300] [C30/37-1]

Column 'C.9.1" [Square 300] [C30/37-1]
" Column 'C.10.1" [Square 300] [C30/37-1]
@ Column'C.11.1" [HE-A 200] [S 355]
@ Column'C.12.1" [HE-A 200] [S 355]
| Ignore || Activate | Convert

[]lignored (0)
[ Matching (0)

Connected to Tekla Structures 21.1
Loading StruXML file C\Users\lwona\Desktopi2016-03-18 Tekla Import test\FD models\Complete structure.struxml
Processing StruXML entities
Refreshing Tekla data
i Loading StruXML file succeeded

Figure 2-23

When selected objects are converted, they appear in the Tekla model (Figure 2-24) and their status
in the Tekla StruXML Import will change to Matching (Figure 2-25).

Figure 2-24
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e |

&) Tekla StruXML Import - O bre
Import | Materials | Sections | Options

File name CAUsers\lwona\Desktoph2016-03-18 Tekla Import test\FD models\Complete structure.struxm
Type StruXML Tekla

Beam

- Column 'C.1.1" [HE-A 200] [5 355)
Column (61)

Column 'C.2.1" [Square 300] [C30/37-1]

+/| Plate (3)
W “e G3) Column 'C.3.1" [Square 300][C30/37-1]
3
Stat Column 'C.4.1" [Square 300] [C30/37-1]
atus
" Column 'C.5.1" [Square 300] [C30/37-1]

Column 'C.6.1" [HE-A 200] [S 355]
Column 'C.7.1" [Square 3001 [C30/37-1]
Column 'C.8.1" [Square 300] [C30/37-1]
Celumn 'C.9.1" [Square 300] [C30/37-1]
Celumn 'C.10.1" [Square 300] [C30/37-1]
Column 'C.11.1"[HE-A 2001 [5 355]
Column 'C.12.1" [HE-A 2001 [5 355]

Activate

gnored

Matching (99)

Ignaore

Column "COLUMMN' [HEAT00] [S355JR]
Column"COLUMMN' [300+300] [C30/37]
Column "COLUMMN' [300+300] [C30/37]
Column "COLUMMN' [300*300] [C30/37]
Column"COLUMMN' [300+300] [C30/37]
Column "COLUMMN' [HEAT00] [S355JR]
Column "COLUMN' [300%300] [C30/37]
Column"COLUMMN' [300*300] [C30/37]
Column "COLUMMN' [300+300] [C30/37]
Column "COLUMN' [300%300] [C30/37]
Column "COLUMMN' [HEAT00] [S355)R]
Column "COLUMMN' [HEAT00] [S355JR]

Convert

©

About  Manua

Close

Figure 2-25

B. Convert axes and storeys

Since version 1.1.004, it is possible to convert struxml axes and storeys to Tekla grid system.

To convert FEM-Design axes and storeys, press the Convert axes/storeys button (Figure 2-26).
This function works independently from the Convert objects.

The axes and storeys are converted according to following rules:

Each axis is created as separate grid line in Tekla, and is placed on each converted level

(storey).

If a file contains axes, but no storeys, the original Tekla grid will be deleted and a new grid

system will be inserted on the base (+0) level.

If a file contains both axes and storeys, the original Tekla grid system will be deleted and a new

grid system will be inserted on every level (storey).

If a file contains storeys, but no axes, The Tekla grid system will be modified, and the original

Tekla grid will be inserted on every level (storey).
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€ Tekla StruXML Impaert —

Import | Materials I Sections | Options

File name C\Users\lwona\DesktophTest 2

Type StruXML Tekla
Beam (0)

Column ()
[+] Plate (2)

Wall (0)

Status

New (0)

Modified (0)

Deleted (0}

Conflicted (0)

Ignored (0)
[[]Matching (2)

| Ignore || Activate | convert axes/storeys || Convert abjects

Loading StruXML file C\Users\lwona\Desktop\Test 2 - only grids + added storeys and grids.struxml
Processing StruXML entities
Refreshing Tekla data
0 Loading StruXML filz succeeded
Creating Plate 'P.1.1'
Creating Plate 'P.2.T'
@ Converting objects completed
@® Converting axes/storeys completed!

-~

About  Manual

Close

Figure 2-26

C. Press Close to close the Tekla StruXML Import Tool.
If you do not see your model in Tekla, or you see only part of it:

- double click in the drawing area and adjust the View depth
- right click in the drawing area and select Fit work area to Entire Model

Interrupt

Properties...
Meve

- FitWork Area to Entire Model
Redraw View
Zoom
Update Window
Next Window

3k Create Clip Plane

T

Creste General Arrangement Drawing..

2 View Properties

[save| Loag] [ standard T —

Representation

View
Name: [3d

A Angle: FES | B Rstation around Z: [-30.00
Projection: [ orthogonal | Rotation sround %:  [20.00

[ Color and transparency in all views: [ standard

] [Representatior

Visibility

view dept: B -—
Down: -—

[ Visibility of object types:

[AVisible object group: | standard v ‘ | Object g,oup_"‘

Figure 2-27
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2.3.6. Update

If you continue working on the (previously imported to Tekla) model in FEM-Design, you can use the
new version of that model to update the current version of Tekla model. The current version of the
model can include some changes applied after the previous struxml model was imported. A brief
workflow is shown in Figure 2-28

FEM-Design model
“Version 1- Import struxml_1 to CREATE

Tekla model

i -Version 1-
(struxml_1) new model in Tekla

FEM-Design model

Import struxml_2 to UPDATE Tekla model
-Version 2- .

the current model in Tekla -Version 2-

(struxml_2)

Figure 2-28

When importing another version of the same FEM-Design model, changes are recognized in
comparison to the previously imported version and to the current version of Tekla model. Following
changes are recognized:

In StruXML model:

- New object

- Modified objects
o  Geometry
e Section
e Material
e ID

- Deleted objects
In Tekla model:

- Modified objects

e (Geometry
e Section
e Material

- Deleted objects

When updating Tekla object to the FEM-Design version, the previous object in Tekla is deleted, and
a new object that matches FEM-Design properties, is created in its place. It is not possible to update
any Tekla object on parameter level.

Please follow the next example, to understand the idea of the update mechanism.
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Example:

A certain FEM-Design model was first imported to Tekla. Afterwards the model was further
developed in FEM-Design, and some changes have been made also in Tekla.

a. Model modifications in FEM-Design
Following changes have been applied (Figure 2-29):

- two columns has changed the section,
- one plate has changed the material,

- one wall was deleted,

- one new column was created.

The model was saved as a new struxml file with new name. This modified FEM-Design model is what
we call *FEM-Design Model - Version 2’ on Figure 2-28.

MNew

Mew material in the this plate

Pz it et b
.\Rgﬁy\ 1 ~ /é
— |
1 ST
7.\\3\1‘% QQQ
«J/\\m;% 1=
) T Qﬁg
- |

Figure 2-29
b. Model modifications in Tekla
Following changes have been applied (Figure 2-30):
- wall's geometry has been modified (openings were modified).

This modified Tekla model is what we call *Tekla Model - Version 2’ on Figure 2-28.
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Figure 2-30

c. Update

In order to update the current version of the Tekla model, start the Tekla StruXML Import tool, and
browse for the new version of the FEM-Design model.

Upon loading the file, one can see a list of all changes (Figure 2-31). If some objects are marked in
red, it means that some additional mapping is required. In such case, perform the missing material
and sections mapping first.

€ Tekla StruXML Import — O ®
! Import | Materials | Sections | Options | |
Filz name CAUsers\lwona\Desktop\Tekla Import modelstruxml_2 struxml
Type StruXML Tekla
Beam {0) @ Column'C.48.1' [HE-A 180] [S 355] Column 'Column’ [HEA200] [S255/R]
E::;I:emrcls}{ﬂ) @ Column'C.53.1' [HE-A 180] [ 355] Column 'Column’ [HEAZ200] [5355JR]
Wall @ @] MRS 200 C30/37-1] Panel "Wall ' [3000+200] [C30/37]
Status @) Wall"W.28.1' [200] [C30/37-1] Panel "Wall ' [3000*200] [C30/37]
[ New (1) @ Plate'P.5.1'[250] [C30/37-1] Slab ‘Plate’ [250] [C25/30]
Modified (4) ) Column’C.62.1° [Rectangle 150x500] [C25/30]
[/ Deleted (1)
Conflicted (0}
Ignored (0}
["]Matching (94)
Ignore ” Activate Convert
Figure 2-31
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By default, only the changes are checked to be visible. In this example there is 1 new object, 4
objects are modified, and 1 object is deleted. The remaining 94 objects are matching (matching
objects are not displayed by default).

In order to have better overview of the model changes, one can decide to display only one type of
modification at a time, e.g. display only New, or only Modified, etc.
New objects

Display only new objects (Figure 2-32). There is one new column added in FEM-Design (struxml)
model. In order to add it to Tekla model, select the cell and press Convert.

! € Tekla StruXML Import - O X

% Import | Materials | Sections | Options

1| File name ChUsers\lwonat\Desktoph\Tekla Import modelstruxml_2.struxml] Browse
1

Type StruXML Tekla
Beam (0] @ Column’C.62.1° [Rectangle 150x500] [C25/30] -
Column (62)
Plate (5)
Wall (33)
Status
New (1)
[[] Modified (4)
[] Deleted (1)

Conflicted (0)

Ignored  (0)
[C]Matching (94)

Ignore Activate — Convert

Figure 2-32

New column is added into Tekla model, and its status will change to Matching.

MNew (0)
[ Modified (4)
[|Deleted (1)

Conflicted (0)

Ignored  {0)
[ Matching (95)

Ignore Activate Convert

Creating Wall 'W.32.1

Creating Wall 'W.33.1

Creating Plate 'P.5.7'

Convertin e o ot

Converting objects completed

Loading StruXML file C\Users\lwona\Desktop\Tekla Import modelstruxml_2.struxm

Processing StruXML entities
Refreshing Tekla data

@ Loading StruXML file succeeded

Figure 2-33
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Modified objects
Now, let's look at modified objects (Figure 2-34).

- Two columns in FEM-Design (struxml) changed their sections from HEA200 to HEA180
(therefore the section name [HE-A 180] is bolded). When looking at the corresponding
object in Tekla, one can see what the original section was [HEA 200].

- One panel (wall) changed its geometry in Tekla model (therefore, the Panel word is
bolded).

- One slab changed its material in FEM-Design from C25/30 to C30/37 (therefore, the
material name [C30/37-1] s bolded).

&) Tekla StruXML Import - ] *

Impaort | Materials | Sections | Cptions |

File name CAUsers\iwona\Desktop\Tekla Import modelstruxm]_2.struxml Browse

Type StruXML Tekla
Beam (D) @ Column'C.48.1' [HE-A 180] [S 355] Column 'Column’ [HEAZ00] [S355JR]
ﬁ:"""”(‘ﬂm) ) Column'C.53.1' [HE-A 180] [S 355] Column 'Column’ [HEA200] [S355JR]
7| Plate — : , o .
Wall G3) ‘k:) Wall 'W.28.1' [200] [C30/37-1] Panel "Wall ' [3000*200] [C30/37]
() Plate 'P.5.1'[250] [C30/37-1] Slab 'Plate' [250] [C25/30]
Status
Mew (0)
[ Modified (4)
[]Deleted (1)

Conflicted (0)

lgnored (0}
["]Matching (95)

lgnore || Actvate

Figure 2-34

In order to apply the three changes made in FEM-Design to the Tekla model, select the three
objects and press Convert (Figure 2-35).

Type StruXML Tekla
Beam (0} @ Column'C48.1' [HE-A 180] [S 355] Column "Column’ [HEA200] [S255JR]
il Column (62) @ Column'C.53.1' [HE-A 180] [S 355] Column ‘Column’ [HEA200] [S355JR]
v
Status @ Plate'P.5.1" [250] [C30/37-1] Slab Plate’ [250] [C25/30]
Mew (0)
[ Modified (4)
[ ] Deleted (1)

Conflicted (0)

Ignored (0}
[[]Matching (95)

Ignore ” Activate — COnVErt

Figure 2-35
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The two columns have a new profile in Tekla now, and the slab changed the material to C30/37. All
three objects changed their status to Matching.

&) Tekla StruXML Import

Type
Beam (0)
[+/] Column (62)
[+/] Plate (3)
[ Wall (33)
Status
Mew (0)
[+/] Modified (1)
[| Deleted (1)

Conflicted (0)

lgnored  (0)
[[]Matching (98)

Import | Materials | Sections | Options

File name CA\Usershlwona\Desktoph\Tekla Import modelstruxml_2.struxm|

Browse

StruXML
@ wall'w.28.1" [200] [C30/37-1]

Tekla
Panel "Wall ' [3000°200] [C30/37]

Ignore Activate

Refreshing Tekla data

Creat

g Column 'C.62.1

@ Loading StruXML file succeeded

@ Converting objects completed

Modifying Plate "P.5.1

Madifying Column 'C.48.1"

2.1

Maodifying Column 'C.5

Ignored objects

@ Converting objects completed

Figure 2-36

The last object that is left in Modified category is the wall W.28.1 that was modified in Tekla. Here, if
you want to bring the original version of the wall that exist in the FEM-Design (struxml) model,

select it and press Convert. The wall in Tekla will be modified to the previous version.

But if you want to keep the current modified version of the wall in Tekla, just select the object and

press Ignore.

€ Tekla StruXML Import

-

Type
Beam (0)
Column (62)
Plate (5)
Wall (33)
Status
New (0)
Modified (0)
[[| Deleted (1)

Conflicted (0)

[] Ignored (1) <=
[]Matching (98)

Import | Materials | Sections | Options

File name Ch\Users\lwonatDesktophTekla Import modefstruxm]_2.struxml

Browse

StruXML

Tekla

Ignore Activate

Convert

Figure 2-37
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No modification will be done to Tekla wall, and its status will change to Ignored (Figure 2-37). In
Ignored, you will be able to see the list of all objects that were not automatically converted to Tekla
model.

If you want to activate an ignored object, select it and press Activate. This way, the object will be
move to its original category.

Ignore can also be used if, for some reason, you do not want to automatically update the Tekla
objects with FEM-Design change (maybe you prefer to do it manually).

To summarize: Ignore can be used in two situations:

- When an object was changed (modified / deleted) only in Tekla and you want to keep this
state, and do not update the object to the previous version from FEM-Design (struxml).

- When an object was changed (modified / deleted) only in FEM-Design and you do not want
to automatically update the Tekla model with this change.

Deleted objects

Display only deleted objects (Figure 2-38). There is one wall that was deleted in FEM-Design model
(struxml).

&) Tekla StruXML Impert — a by

Import | Materials | Sections | Options

. Ol lear vimmah Necktnm Teklz Imnar miodelbztruwen] 2 strism
Filz name CAUsers\lwona\Desktop\Tekla Import modehstruxml_2.struxe Browse

Type StruXML Tekla
Beam (0] D Wall w28 1 2001i030/27 1 Panel "Wall ' [3000~200] [C20/37]
[+] Column (62)
[+/] Plate (5)
WWall 33)

Status

Deleted (1)

Conflictad

[Jignored (1)
[1Matching (98)

lgnore Activate Convert

Figure 2-38

If you wish to update the Tekla model (delete that wall), just select the object and press Convert.
The wall will be deleted from Tekla and its status will change to Matching.

Ignaore Activate Convert

reating Column 'C.62.1

-
L
-
L

@

@

Figure 2-39

(If you do not want to delete that wall in Tekla, select the object and press Ignore).
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Conflict

In case any object was modified in both places, i.e. in FEM-Design and in Tekla, one has to decide
which version of the object to accept (it is not possible to keep the state of Tekla object and update
it only with the change from FEM-Design).

To demonstrate an example of a conflict, let’s assume that in the next round, a slab was modified in
FEM-Design (opening was added), and the same slab was also modified in Tekla (slab boundaries
were extended).

Upon loading the struxml file containing another version of the FEM-Design model, a conflict is
recognized (Figure 2-40). Both changes were made to the slab’s geometry therefore the name of the
objects are bolded in both sides.

In order to accept the version of the plate from FEM-Design (struxml), one should select the object
and press Convert. The slab in Tekla will be updated to the current version from FEM-Design (but
the change applied in Tekla to that slab will be lost).

In order to keep the version of the slab in Tekla, and do not automatically update it to FEM-Design
version, one should select the object and press Ignore. This way we can keep the Tekla
modification (and perhaps apply the other modification manually in Tekla).

Type StruXML Tekla
Beam (0} ) Plate'P.5.1' [250] [C20/37-1] Slab 'Plate’ [250] [C30/37]
Column (62)
Plate (5)
Wall (33)

Status

Conflicted (1)
[Jignored (1)
[[1Matching (98)

lgmore Activate Convert

Figure 2-40

2.4. Limitations and future development

Tekla StruXML Import 1.00.000 is the first release of the tool and has certain limitations.
Development of this tool will continue and one can expect many improvements in the next versions.

Recognized limitations:

- The original name of the Tekla model cannot be changed if one wants to update that
model later.

- Contour of the slab / wall including arc is not supported and such slab /wall will not be
imported to Tekla.

- Openings in the slab / wall including arc are not supported and such openings will not
be created in Tekla (slab / wall will be imported).

Future development:

- Import axes and storeys as grid system to Tekla

- Import profiled panels to Tekla.

- Improvements in mapping (saving mapping, introducing Tekla material and section
catalogs into the tool).
Improvements in the user input (more categories for Name and Class)
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